
•  Revision Cloud

•  Wipeout

•  Spline

•  Fit Points

•  CV

•  Knots

•  Kink

•  Weight

 Key Terms 

 Learning Objectives 
After completing this chapter, you will be able to:
• Create Revision clouds
• Create Wipeouts
• Draw NURBS splines using the Spline tool
• Edit NURBS splines using the Edit Spline tool

Chapter 18
Working with Advanced 

Drawing Options
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UNDERSTANDING THE USE OF REVISION CLOUDS
A revision cloud is a polyline of sequential arcs to form a cloud-shaped object. If you review 
or redline drawings, you can increase your productivity by using the revision cloud feature to 
highlight your markups.

You can create a revision cloud from scratch, or you can convert objects, such as a circle, ellipse, 
polyline, or spline to a revision cloud. A style is available to make the cloud look as though it 
was drawn with a calligraphy pen.								      
	

CREATING REVISION CLOUDS                                
  Ribbon:   Home > Draw > Revision Cloud drop-down                                                                                                           
  or Annotate > MarkUp > Revision Cloud drop-down	  Toolbar:  Draw > Revision Cloud	                                                      
  Command:  REVCLOUD/RC      				   				                                                          

Revision cloud is the sequential arc of polylines and is used to create

Figure 18-1  The tools in the 
Revision Cloud drop-down

 
a cloud-shaped object. Revision clouds can be used to highlight the 
details of a drawing. The tools to draw a revision cloud are grouped 
in the Revision Cloud drop-down of the Draw panel in the Ribbon, 
see Figure 18-1. Remember that the tool that was used last to create 
a revision cloud will be displayed in this drop-down. The different 
methods to draw a revision cloud are discussed next. 

Rectangular Revision Cloud
To draw a rectangular revision cloud, choose the Rectangular Revision Cloud tool from the 
Revision Cloud drop-down in the Draw panel; you will be prompted to specify the first point. 
Specify the first point or enter coordinates. Next, specify the opposite corner point of the 
rectangle. The prompt sequence that will follow when you choose this tool is as follows:

Minimum arc length: 0.5000   Maximum arc length: 0.5000   Style: Normal Type: 
Rectangular
Specify first corner point or [Arc length/Object/Rectangular/Polygonal/Freehand/Style/
Modify] <Object>: Specify first corner point of rectangle.
Specify opposite corner: Specify opposite corner point of rectangle.

Polygonal Revision Cloud
To draw a polygonal revision cloud, choose the Polygonal Revision Cloud tool from the Draw 
panel (refer to Figure 18-1); you will be prompted to specify the first point. Specify the first 
point; you will be prompted to specify the next point. Keep specifying the points until the 
desired polygonal revision cloud is created. Press ENTER to terminate the command. The 
prompt sequence that will follow when you choose this tool from the Draw panel is as follows:

Minimum arc length: 0.5000   Maximum arc length: 0.5000   Style: Normal Type: 
Polygonal
Specify start point or [Arc length/Object/Rectangular/Polygonal/Freehand/Style/Modify] 
<Object>: Specify the start point of the revision cloud.
Specify next point: Specify the next point of the revision cloud.
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Specify next point or [Undo]: Specify the next point of the revision cloud.
Specify next point or [Undo]: Specify the next point of the revision cloud, or press ENTER to 
exit the tool.

Freehand Revision Cloud
To draw a freehand revision cloud, choose the Freehand Revision Cloud tool from the Draw 
panel (refer to Figure 18-1); you will be prompted to specify the first point. Specify the first point. 
Now, as you move the cursor, different arcs of the cloud with varied radii are drawn. When the 
start point and endpoint meet, the revision cloud is completed and you get a message that the 
revision cloud has been created. The prompt sequence that will follow when you choose this 
tool from the Draw panel is as follows:

Minimum arc length: 0.5000   Maximum arc length: 0.5000   Style: Normal Type: 
Freehand
Specify first point or [Arc length/Object/Rectangular/Polygonal/Freehand/Style/Modify] 
<Object>: Specify the start point of the revision cloud.
Guide crosshairs along cloud path...
Revision cloud finished.

While making any type of revision cloud, you can define the length of the arcs to be drawn 
using the Arc length option from the Command prompt. The arcs drawn using this option 
will be of constant length. You can convert a closed loop into a revision cloud using the Object 
option. Note that the selected closed loop should be a single entity such as an ellipse, a circle, a 
rectangle, a polyline, and so on. The Style option is used to define the arc style for the revision 
cloud. The default style is Normal that creates a revision cloud similar to the one shown in 
Figure 18-2. You can change the style to Calligraphy to create a revision cloud similar to the 
one shown in Figure 18-3.

Note
The REVCLOUD stores the last used arc length in the system registry. This value is multiplied by 
the DIMSCALE value to provide consistency when the program is used with drawings that have 
different scale factors.

Figure 18-3  Calligraphy revcloudFigure 18-2  Creating revcloud
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CREATING WIPEOUTS
  Ribbon:  Home > Draw > Wipeout or Annotate > Markup > Wipeout                              
  Command:  WIPEOUT	     Menu Bar:  Draw > Wipeout		            

The Wipeout tool is used to create a polygonal area to cover the existing objects with the 
current background color. The area defined by this tool is governed by the wipeout  
frame. The frame can be turned on and off for editing and plotting the drawings, 

respectively. This tool can be used to add notes and details to a drawing. The prompt sequence 
that will follow when you choose the Wipeout tool from the Draw panel is as follows:

Specify first point or [Frames/Polyline] <Polyline>: Specify the start point of the wipeout.
Specify next point: Specify the next point of the wipeout.
Specify next point or [Undo]: Specify the next point of the wipeout.
Specify next point or [Close/Undo]: Specify the next point of the wipeout.

Figure 18-4 shows a drawing before creating a wipeout and Figure 18-5 shows a drawing after 
creating the wipeout. 

Figure 18-4  Drawing before creating a wipeout Figure 18-5  Drawing after creating a wipeout

If you do not want the frame of the wipeout to be displayed, enter F at the Specify first point 
or [Frames/Polyline] <Polyline> prompt and turn the frame off. The display of frames of 
all existing wipeouts will be turned off. Also, the display of frames of all new wipeouts will be 
turned off.

CREATING NURBS
  Ribbon:  Home > Draw > Spline Fit	    Menu Bar:  Draw > Spline > Fit Points	      
  Toolbar: Draw > Spline           		    Command:  SPLINE/SPL		       

The NURBS is an acronym for Non-Uniform Rational Bezier-Spline. These splines are 
considered true splines. In AutoCAD LT, you can create NURBS using the Spline tool. 
The spline created using the Spline tool is different from the spline created using the 

Polyline tool. The nonuniform aspect of the spline enables the spline to have sharp corners 
because the spacing between the spline elements that constitute a spline can be irregular. Rational 
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means that irregular geometry such as arcs, circles, and ellipses can be combined with free-form 
curves. The Bezier-spline (B-spline) is the core that enables accurate fitting of curves to input 
data with Bezier’s curve-fitting interface. Not only are spline curves more accurate compared to 
smooth polyline curves, but they also use less disk space. 

The prompt sequence to draw a spline with six fit points is given below.

       Choose the Spline tool. 
Current settings: Method=Fit   Knots=Chord
Specify first point or [Method/Knots/Object]: Select point P1
Enter next point or [start Tangency/toLerance]: Select point P2.
Enter next point or [end Tangency/toLerance/Undo]: Select point P3.
Enter next point or [end Tangency/toLerance/Undo/Close]: Select point P4
Enter next point or [end Tangency/toLerance/Undo/Close]: Select point P5.
Enter next point or [end Tangency/toLerance/Undo/Close]: Select point P6 and press 
ENTER to end the process of point specification.

Options for Creating Splines
On invoking this tool, you can use the following options to create splines.

Object
This option allows you to change a 2D or 3D spline fitted polyline into a NURBS feature. The 
original splined polyline is deleted if the system variable DELOBJ is set to 1, which is the default 
value of the variable. You can change a polyline into a splined polyline using the Spline option 
of the Edit Polyline tool.

Method
In AutoCAD LT, you can create a spline by specifying fit points or control vertices. By default, a 
spline is created by specifying the fit points. Fit points are the points through which the spline 
will pass. Control vertices determine the shape of the curve. To set the method to create a spline, 
enter M at the Specify first point or [Method/Knots/Object] prompt. Then, you need to specify 
the method at the Enter spline creation method [Fit/CV] prompt. Figure 18-6 shows the spline 
created by using the Fit method. Figure 18-7 shows the spline created by using the CV method. 

Figure 18-6  Spline drawn by using 
the Fit method

Figure 18-7  Spline drawn by using 
the CV method
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Note
On selecting a spline, a grip will be displayed at the start point. Left-click on the grip; a shortcut 
menu will be displayed. Now, you can choose an appropriate option to display the fit points or the 
control vertices, as shown in Figure 18-8. 

Knots
If you have selected the Fit method, the Knots option will be displayed at the Command prompt, 
as given below.

Enter spline creation method [Fit/CV] <CV>: FIT
Current settings: Method=Fit   Knots=Uniform
Specify first point or [Method/Knots/Object]:

You can specify three types of knots: Chord, Square root, and Uniform. Figure 18-9 shows the 
splines formed by using three different knot options.

Figure 18-9  Splines with different knot optionsFigure 18-8  Control vertices and fit points of 
a spline

Degree
If you have selected the CV method, then the Specify first point or [Method/Degree/Object] 
prompt will be displayed. Enter D at the Command prompt and specify the degree.

Close
This option allows you to create closed NURBS. When you use this option, AutoCAD LT will 
automatically join the endpoint of the spline with the start point, and you will be prompted to 
define the start tangent only. 

Tolerance
This option is used to control the fit of the spline between specified points. By default, this value 
is zero; as a result, the spline passes through the points by which it is created. Using this option, 
you can specify the tolerance values that will govern the spline creation, see Figure 18-10. The 
splines will be offset from the specified point by a distance equal to the tolerance value. The 
smaller the value of the tolerance, the closer the spline will be to the specified points. 
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Start and End Tangency
This option is used to control the tangency of a spline at its start point and the endpoint. On 
entering T at the Enter next point or [start Tangency/toLerance] or Enter next point or [end 
Tangency/toLerance/Undo/Close] prompt, you will be prompted to specify the tangent. Specify a 
point; the tangency will be determined by the slope of the spline at the specified point. Remember 
that after specifying the start point of the spline, you need to specify the start tangency. If you 
specify the second point, the default value will be used for the tangency. Similarly, you need to 
specify the end tangency after specifying the last point of the spline. Figure 18-11 shows a spline 
with start and end tangencies. The virtual tangent line is for reference.

Figure 18-10  Creating a spline with 
the Tolerance of 0 and 3

Figure 18-11  Spline with start and 
end tangencies

EDITING SPLINES
  Ribbon:  Home > Modify > Edit Spline	    Menu Bar:   Modify > Object > Spline	    
  Toolbar:  Modify II > Edit Spline	    Command:  SPLINEDIT		       

The NURBS can be edited using the Edit Spline tool. Using this tool, you can fit data in 
a selected spline, close or open a spline, move vertex points, and refine or reverse a spline. 
Apart from the ways mentioned in the preceding command box, you can also choose the 

options available in the shortcut menu that will be displayed when you right-click after selecting 
a spline. The prompt sequence that will follow when you choose the Edit Spline tool in the 
Modify panel is given next.

Select spline: Select the spline to be edited if not selected already, using the above-mentioned shortcut 
menu.
Enter an option [Close/Join/Fit data/Edit vertex/convert to Polyline/Reverse/Undo/eXit] 
<eXit>: Select any one of the options.

Options for Editing Splines
On invoking this tool, you can use the following options to edit splines.

Fit data
When you draw a spline, the spline fits as per the specified points (data points). The Fit data 
option allows you to edit these points. You can add, delete, or move the data points. These data 
points or control points are also referred to as fit points. For example, if you want to redefine 
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the start and end tangents of a spline, select the Fit data option and then select the Tangents 
option. The prompt sequence that will follow when you invoke this option is given next.

Select spline: Select the spline to be edited.
Enter an option [Close/Join/Fit data/Edit vertex/convert to Polyline/Reverse/Undo/eXit] 
<eXit>:  F 
Enter a fit data option [Add/Close/Delete/Kink/Move/Purge/Tangents/toLerance/eXit] 
<eXit>: T 

The start and end tangent points can be selected or their coordinates can be entered. The 
options available within the Fit data option are as follows:

Add 
You can use this option to add new fit points to the spline. When you invoke this option, 
you will be prompted to specify the existing fit point on the spline. After selecting the              
existing fit point, you will be prompted to specify the location of the new control points. 
The fit point you select and the next fit point appear as selected grips. You can now add a fit 
point between these two selected fit points, as shown in Figure 18-12. If you select the start 
point or endpoint of the spline, only they get highlighted. When you select the start point 
of the spline, you are prompted to specify whether you want to add the new fit point before 
or after the start point of the spline. AutoCAD LT will continue prompting for the location 
of new control points until you press ENTER at the Specify new point <exit> prompt.

Close/Open 
This option is used to close an open spline or open a closed spline, see Figure 18-13. If the 
spline is open, the Close option is available and if the spline is closed, the Open option is 
displayed.

Figure 18-12  The original spline and the 
edited spline after adding fit points

Figure 18-13  An open spline and a closed spline

Delete 
This option is used to delete a selected fit point from a spline. You can continue deleting 
fit points from a spline until only two fit points are left in the spline.

Kink
This option is used to add a knot and a fit point to the selected point. On selecting this option, 
you will be prompted to specify a point on the spline. Select a point; a kink will be added.
 Move
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You can move fit points by using this option. When you select this option, the start point of 
the spline is highlighted and the following prompt sequence appears:

Specify new location or [Next/Previous/Select point/eXit] <N>: Select a new location for 
the start point using the mouse pick button or enter any one of these options.

You can enter N if you want to select the next point, P if you want to select a previous point, 
or S if you want to select any other point. If you enter X at the preceding prompt, you can 
exit the tool. Figure 18-14 shows the movement of data points in a spline. Remember that 
this option is used to move only the data points on the spline and not the control points on 
the Bezier control frame.

Purge
This option is used to remove fit point data from a spline. This reduces the file size, which 
is useful when a drawing, for example, a landscape contour map, contains large number of 
splines. Purging simplifies the spline definition and the drawing file size.

Tangents
This option is used to modify the tangents of the start and endpoints of a selected spline, 
see Figure 18-15. When you select this option, you will be prompted to specify the start and 
end tangents of the spline. You can specify the start and end tangents or use the systems 
default tangents.

Figure 18-14  The original spline and the 
edited spline after moving the data points

Figure 18-15  The original spline and the spline 
after modifying the start and end tangents

toLerance
This option is used to modify the fit tolerance values of a selected spline. As discussed, while 
creating the splines, different tolerance values produce different splines. A smaller tolerance 
value creates a spline that passes very closely through the definition points of a spline. When 
you invoke this option, you will be prompted to specify the tolerance value for the spline. 

eXit
This option is used to exit the Fit data option of editing splines.

Close/Open
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This option is used to close an open spline or open a closed spline. When you select the Close 
option, AutoCAD LT lets you open, fit data, edit the vertex, convert spline to polyline, or re-
verse the spline. 

Edit Vertex
This option is used to refine a spline by adding more control points in it, elevating the order, 
or adding weight to vertex points. The prompt sequence that will follow when you invoke this 
option is given next.

Enter an option [Open/Fit data/Edit vertex/convert to Polyline/Reverse/Undo/eXit] 
<eXit>: E 
Enter a vertex editing option [Add/Delete/Elevate order/Move/Weight/eXit] <eXit>:

The options in this prompt are discussed next. 

Add
This option is used to add more control points on the spline. When you invoke this option, 
you will be prompted to specify the location of the new point on the spline. You can directly 
specify the location of the new point using the left mouse button. A new control point will 
be added at the specified location.

Delete 
This option is used to delete a selected fit point from a spline.

Elevate order
This option is used to increase the order of a spline curve. The order of a curve can be 
defined as the highest power of the algebraic expression that defines the spline plus 1. For 
example, the order of a cubic spline will be 3 + 1 = 4. Using the Elevate order option, you 
can increase this order for a selected spline. This results in more control points on the curve 
and a greater possibility of controlling the spline. The value of the spline order varies from 
4 to 26. You can only increase the order and not decrease it. For example, if a spline order 
is 18, you can elevate its order to any value greater than 18, but not less than 18.

Move
When you draw a spline, it is associated with the Bezier control frame. The Move vertex 
option allows you to move the vertices of the control frame. The Move option is similar to 
the Move option of Fit data for editing the splines. The prompt sequence that follows when 
you invoke this option is given next.

Enter an option [Close/Join/Fit data/Edit vertex/convert to Polyline/Reverse/Undo/eXit] 
<eXit>: E 
Enter a vertex editing option [Add/Delete/Elevate order/add Kink/Move/Weight/eXit] 
<eXit>: M 
Specify a new location or [Next/Previous/Select point/eXit] <N>:

Weight
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You can also add weight to any of the control vertices of a spline by using this option. When 
weight is added to a particular vertex, the spline gets pulled more towards it. Similarly, a 
lower value of weight of a particular spline vertex will result in the spline getting pulled less 
towards that particular vertex. In other words, adding weight to a particular point will force 
the selected point to maintain its tangency with the point. The more weight added to the 
point, the more is the distance through which the spline will remain tangent to the point. By 
default, the spline gets pulled equally towards the vertices of the spline. The default value 
of weight provided to each control point is 1.0 and can have only positive values. Once you 
have added the weight to a point, you can proceed to the next point. You can also directly 
select the point to which the weight has to be added. The prompt sequence for using this 
option is given next.

Enter an option [Close/Join/Fit data/Edit vertex/convert to Polyline/Reverse/Undo/eXit] 
<eXit>: E 
Enter a vertex editing option [Add/Delete/Elevate order/Move/Weight/eXit] <eXit>: 
W 
Spline is not rational. Will make it so.
Enter new weight (current = 1.0000) or [Next/Previous/Select point/eXit] <N>: S 
Specify existing fit point on spline <exit>: Select a fit point
Enter new weight (current = 1.0000) or [Next/Previous/Select point/eXit] <N>: 3 
Enter new weight (current = 1.0000) or [Next/Previous/Select point/eXit] <N>: Exit 

Join
If a spline, line, or an arc is joined to the spline that is being edited, then you can use this option 
to join those entities to the spline. On choosing this option, you will be prompted to select an 
open curve. Select the curves to be joined and press ENTER; all curves will be joined to the 
spline, and knot and fit points will be added at the joining point. The prompt sequence for 
using this option is given next.

Enter an option [Close/Join/Fit data/Edit vertex/convert to Polyline/Reverse/Undo/eXit] 
<eXit>: J
Select any open curves to join to source: Select an object. 1 found
Select any open curves to join to source: Select an object. 1 found, 2 total
Select any open curves to join to source:
2 objects joined to source 

Reverse
This option is used to reverse the spline direction. This implies that when you apply this option 
to a spline, its start point becomes its endpoint and vice versa. 

convert to Polyline
This option is used to convert a spline into a polyline. On specifying this option, you will be 
prompted to specify a precision value. Specify a value between 0 and 99, and then press ENTER; 
the spline will be converted into a polyline. The precision value determines the accuracy of the 
resulting polyline. 

Undo
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This option will undo the previous editing operation applied to a spline within the current 
session of the Edit Spline tool. You can continue to use this option till you reach the spline as 
it was when you started to edit it.

 Self-Evaluation Test 
Answer the following questions and then compare them to those given at the end of this 
chapter:

1.	 The __________ can be edited using the Edit Spline tool.

2.	 The __________ option of the Fit data option of the Edit Spline tool is used to reduce the 
file size by removing the fit data of the selected splines.

3.	 The Revision Cloud tool in the Draw panel is used to create a cloud-shaped polyline. (T/F)

4.	 The Wipeout tool is used to create a polygonal area to cover the existing objects with the 
current background color. (T/F)

 Review Questions 
Answer the following questions:

1.	 Which of the following options can be used to reverse the direction of spline creation while 
editing a spline?

	 (a) Fit data			   (b) Refine
	 (c) Reverse			   (d) Weight

2.	 If the value of Fit tolerance of a spline is __________, the spline passes exactly through the 
fit points of the spline.

3.	 You need to set the degree of a spline, if you are drawing the spline by using the __________ 
method. 

4.	 Once the Purge option of Fit data is used on a spline, the Fit data option is no longer 
available for the particular spline. (T/F)

Exercise 1
Create the drawing shown in Figure 18-16.

Figure 18-16  Drawing for Exercise 1
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Problem-Solving Exercise 1
Create the drawing shown in Figure 18-17. Some of the reference dimensions are given in the 
drawing. Assume the missing dimensions. 

Figure 18-17  Drawing for Problem-Solving Exercise 1

Problem-Solving Exercise 2
Create the drawing shown in Figure 18-18. Some of the reference dimensions are given in the 
drawing. Assume the missing dimensions.

Figure 18-18  Drawing for Problem-Solving Exercise 2



18-14	                   	                   AutoCAD LT 2020 for Designers

Problem-Solving Exercise 3
Create the drawing shown in Figure 18-19. Some of the reference dimensions are given in the 
drawing. Assume the missing dimensions. 

Figure 18-19  Drawing for Problem-Solving Exercise 3

Problem-Solving Exercise 4
Create the drawing shown in Figure 18-20. Some of the reference dimensions are given in the 
drawing.

Figure 18-20  Drawing for Problem-Solving Exercise 4



Working with Advanced Drawing Options			                                        18-15

Problem-Solving Exercise 5
Create the drawing shown in Figure 18-21. Some of the reference dimensions are given in the 
drawing. Assume the missing dimensions. 

Figure 18-21  Drawing for Problem-Solving Exercise 5



18-16	                   	                   AutoCAD LT 2020 for Designers

Problem-Solving Exercise 6
Create the drawing shown in Figure 18-22. Some of the reference dimensions are given in the 
drawing.

Figure 18-22  Drawing for Problem-Solving Exercise 6

Problem-Solving Exercise 7
Create the drawing shown in Figure 18-23. Some of the reference dimensions are given in the 
drawing.

Figure 18-23  Drawing for Problem-Solving Exercise 7
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Answers to Self-Evaluation Test
1. NURBS, 2. purge, 3. T, 4. T
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